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Chapter 1: About this Guide

The MicroVision Camera is an integral part of the MCS Perfect
Match, IR Track, Input, and Read and Print systems. The camera
reads a variety of readable image types and decodes (or passes)
the image. The software that accompanies the camera is
Windows-based and intended to configure camera operation.

Note: The MicroVision Camera is a productivity tool. It is used to
assist in print production but not to replace standard quality
control procedures.

This document describes how to install and use the camera within
these systems. For systems that print, this document assumes that
you have already installed the MCS Printer software and have
read the accompanying User’s Manual.

Intended Audience

This guide is intended for use by MCS equipment operators.

Basic knowledge of the Microsoft Windows® operating system
and some experience with MCS printing equipment is assumed.

Conventions

The following conventions are used in this guide.

Bold Actions you should take such as text or data to
be typed exactly or items to click.

Italics Items to type for which you must supply a
value.

Getting Help

A complete on-line help system is available in the interface by
selecting the Help item on the Menu bar or the Help icon on the
7 toolbar.




Getting Help
About this Guide

If you need further assistance, please contact MCS via e-mail at
technicalsupport@mcspro.com or call 877.MCS.PROZ (877.627.7769). Telephone
support for MCS equipment is available 8:30am to 8:00pm EST Monday through Friday
and is free of charge.

@ User s Manual
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Chapter 2: Getting Started

Note:

The MicroVision camera can help track, verify, and count on
many pieces of equipment including inserters. The camera takes a
picture of a readable image type and decodes (or passes through)
what it sees. How it translates that data is determined by your
setup. You can read, match, pass, and print data. In order for this
interaction to occur, you must install the camera and the camera
software, and set up the camera via the software as well as
configure how the camera interacts with the MCS Printer. This
chapter describes camera installation and setup.

In general, installation should adhere to the following order,
assuming that physical installation of all the components, except
the camera, has been completed:

If applicable to your setup, install MCS Printer software. See the
Array Imaging System Software User’s Manual and GIS 4250
Software User’s Manual for instructions.

If printing, create Special Batch files. See “Installing Special
Files” on page 2-13.

Install MicroVision Camera software. See “Software Installation”
on page 2-11.

Install the camera dongle and dongle license. See “Dongle
Installation” on page 2-11.

Install the Camera. See “Camera Installation” on page 2-1.
Make any required manual Settings.ini file changes. See
“Settings.ini” on page 2-19.

Add the Camera(s). See “Add Camera” on page 4-1.

Configure Readable Images. See “Readable Image Types” on
page 5-1.

If printing, print the job.

There may be specific instructions based upon the type of MCS
system you are using. Be sure to refer to “MCS Systems” on page
2-12 to review descriptions of your system.

Camera Installation

Camera Placement

There is a variety of MCS equipment on which the MicroVision
camera can be installed:

In This Chapter

¢ Camera
Installation

» Software
Installation

» Dongle
Installation

» System Power
Up

+ MCS Systems
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Camera Installation

Getting Started
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* As an input to other MCS-approved equipment
* Inserters (Friction-Feeder, Swing Arm)

» Card Attachers

* Inkjet Transport Base

*  Continuous Form Transport Base

* Continuous Form Rewinder

» Folders

»  Stitchers

A camera is triggered by cycle count either from an encoder (electrical/software) or an
external trigger (physical device), depending upon camera placement and/or equipment
choice. For example, a Pitney Bowes FlowMaster install utilizes an onboard encoder
whereas a Swing Arm inserter utilizes external triggers to generate cycle and camera
triggers.

MCS provides recommendations based on the type of system you are using.

Inserters

Friction-Feeder Style

*  Camera Placement Option 1 - Facing down toward track, mounted above track

2-2



Camera Installation

Getting Started

* Camera Placement Option 2 - Facing up, reading each piece as it exits the feeder

e Camera Placement Option 3 - Facing up toward the track, mounted under the track
(generally requires modification to track — MCS technicians can determine whether
this is possible)

In general, when facing up or down in the track, the camera is triggered via the inserter’s
on-board encoder.

@ User's Manual
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Camera Installation
Getting Started

When the camera is mounted facing up, reading each piece coming out of the feeder, an
external trigger source (usually a beam sensor) is used. Additionally, limitations of the
read-up configuration are dictated by the placement of the image to decode in relation to
the belts of the feeder.

Swing-Arm Style

»  Camera Placement Option 1 — Facing down toward track, mounted above the track

* Camera Placement Option 2 — Facing up, reading each piece as it exits the feeder
(some limitations may occur on some feeders, as the gears and mechanics of a
typical swing arm may prevent placement of the camera on the last feeder. An MCS
technician can determine what’s available for mounting)

* Camera Placement Option 3 — Facing up toward the track, mounted under the track
(generally requires modification to track — MCS technicians can determine whether
this is possible)

@ User s Manual
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Camera Installation

Getting Started

Swing Arm style inserters are typically set up using an external trigger source. A series
of proximity sensors are mounted near the drive shaft, in conjunction with collars that
are placed to simulate the timing effect of a cycle count, as well as the camera triggers.

Fitted Collars
(mounted on a
drive shaft)

Proximity
Sensors
{connected to
controller box)

An MCS technician will install these and train you on proper adjustment for different
jobs.

Attacher, Transport Bases, Rewinders, Folders, and Stitchers

Normal camera placement on these types of equipment is facing down. These types of
camera installs always require an external trigger source, which is usually each
individual piece (for cut sheet forms) or a timing mark (for continuous forms).

@ User's Manual
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Camera Installation

Getting Started

Physical Installation

Physical installation of the camera involves attaching the camera to the device,
connecting it to the computer, and installing its driver. Equipment choice dictates
whether it will be triggered by an encoder or internal sensor.

To install the camera and camera driver:

1.

Attach Camera to device.

The device can vary and placement can vary depending on the type of printing system
used. See “Camera Placement” on page 2-1.

2. Plug the USB cable connector into camera.
USB Port >
; |
Trigger Port —
]
Note: Make sure that the USB cable is inserted correctly into the camera port. The Narrow end
of the port must match the narrow end of the cable connector.
3. Plug in Trigger cable connections as needed for your setup. See “Equipment
Connections” on page 2-7 to evaluate and complete your physical connections.
4. Plug USB cable into the computer’s USB port.
A separate USB card is recommended. A Windows Found New Hardware message pops
up and the New hardware wizard is launched.
5. Follow the wizard and select Install from Specific Location.
6. Browse to select C:Program Files>MCS Perfect Match>Driver.
7. Click OK.
8. Click Next.
The Install PM USB Driver security message appears.
9. Click Continue anyway.
10. Click Finish.

@ User s Manual
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Camera Installation

Getting Started

Note: The lens cap must be removed from the camera before use.

Equipment Connections

The following diagrams provide a typical description of camera connections for a
swing-arm inserter, PLC-type inserter, and an IR Track.

Note: Additional connections may be needed for inkjet setup.

@ User's Manual
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Camera Installation

Getting Started

Swing-arm Inserter

Proximity Sensor e-stop Exit Sensor Programmable Sensor

"
-

T,
ST

Transport

MicrgVision Controller

Camera DongIeE

@)y OO I s b

> &

Typical Windows XP PC

MicroVision Camera
USB HUB
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Camera Installation
Getting Started
PLC-type Inserter
e-stop Diverter Programmable Sensor
u|§§ i|
}.!‘n”’.
Transport

MicroVision Controller

1w

MicroVision Camera
USB HUB

PLC-Encoder Panel

a8

Typical Windows XP PC
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Camera Installation

Getting Started

IR Track

e-stop Programmable Sensor

i

S,

Transport

MicroVision Controller

Array Print Controller

Camera DongIeE

Typical Windows XP PC . -
MicroVision Camera

USB HUB
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Software Installation

Getting Started

Software Installation

Note:

The first installation of the camera software is done by an MCS factory trained
technician at your facility.

Minimum system requirements to perform upgrades are:

*  Pentium processor

¢ Windows XP Professional
« 1 GBRAM

e CD ROM drive

A serial COM Port connection is needed for the Perfect Match System.

There is no way to manually install or uninstall the software on a PC by deleting or
copying files. You must run Setup . exe to install the software.

To install/upgrade the software:

1.

Dongle Installation

Uninstall any currently installed version using the Windows Remove Programs
mechanism.

Access this window by selecting Start>Control Panel>Add or Remove Programs and
then select the MicroVision Software. Click Remove.

Run Setup.exe for the version you would like to install.
Follow the setup wizard.

The MicroVision camera software requires a hardware dongle. A dongle is a hardware

i [ B device that allows your equipment to communicate with the MCS software. If you

—

attempt to use the software without the dongle installed, it will not function. You will
receive an error.

To install the dongle from the installation CD:

1.

From the installation CD, double-click the file Donglelnstallation/Hdd32.exe in the
Dongle installation folder.

This executable installs the drivers to operate the dongle.
Follow the instructions.

Double-click the file Donglelnstallation/DongleReader.exe.
This program verifies driver installation and proper operation.
Insert the Dongle into a USB port.

The dongle operates in any USB port; however, an internal port is recommended for
added security.

@ User s Manual
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System Power Up

Getting Started

5. Go to Start>Dalso Coreco>Sapeca>License Manager and click Load License.
A window appears with license numbers found.

6. Click the license number for this dongle.

7. Click Open.

System Power Up

MCS System

You must power up the PC before the camera box. This order is important because the
serial connection will only look for data one time. If the PC is not powered up, camera
initialization may fail.

S

The camera can be used with each of the MCS Systems described below:

Read and Print

Match

Match and Print

IR Track

Input Camera

@ User s Manual

The Read and Print configuration of the Perfect Match system combines the camera identification process with the
functionality of an MCS inkjet printer. The camera now controls the print order.

One camera plus an MCS inkjet for printing.

9.4

The Perfect Match system uses the MicroVision camera to match data matrix barcodes, linear barcodes, and OCR
alphanumerics on multiple variable printed pieces.

Matches two or more printed pieces. Uses multiple cameras.

N

Multiple cameras plus a inkjet printer. Matches and prints.

N N

The MCS IR Track system can work on either a continuous form laser printer or in the continuous form bindery lines
to create match jobs with no visible automation marks. This system differs from traditional Read and Print because
there is no database associated with the IR Track. What the camera reads from the laser printed material is what is
transposed to print in invisible ink. Multiple cameras for the back of the laser printer.

1,

P.E<: 0.9

This system decodes and passes data via serial or ethernet connection to some other piece of equipment.

.
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MCS Systems

Getting Started

Read and Print

Note:

The required items for this setup involve both the inkjet software and camera software.
The following text provides a brief description of the needed items.

In the Inkjet software, load the job, template, and data file and make sure your
setupmatch.cfg file is correctly set. Know your unique identifier in the data file. In the
camera software, make the necessary changes for the unique identifier in the Setup.ini
file, create/load the camera job, setup the camera and readable images, and enable the
job.

The following MicroVision Camera functions apply only to setup and operation of the
Read and Print system.

Installing Special Files

MCS has created special files that make it easier for your camera and the MCS Printer to
communicate. Once the camera and MCS Printer software have been installed, you can
install the special files.

These files copy your printer’s Setup.cfg file and make the appropriate changes to the
file needed to interact with the camera. When printing, use the file for your setup (Match
for Perfect Match or Print for Printers) to invoke the printing software.

If you desire changes to your printer’s configuration file and you are using a camera, be
sure to make the changes to the .cfg file for the system, not the default Setup.cfg.

To install special files:

1.

Double-click PrintPCSetup.exe.

Two icons are placed on your desktop. These files allow you to run the camera with
(SetupMatch file) or without (SetupPrint file) an inkjet. These files will be used when
running the job.

Enabling the Job

After all setup and configuration is complete, you must enable the Read and Print print
job from the camera software’s Run tab. The Print button activates the printer and uses
any existing MCS Printer settings. You must have the special files installed on your
desktop.

Missing Records

This option can be used only when your MCS Printer is being used in the system. This
option can be selected while a job is running. It creates a file that contains a list of how
many records are left to print or leftover without printing. You must set the Dupe
Checking line in the MCS Printer config file to 1 for this feature to work.

@ User s Manual
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MCS Systems
Getting Started
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Note:

Note:

Unique Identifier in the Data File

Using the standard MCS Printer data file, place the unique identifier (index number) in a
separate field in your data. Once the field is identified, the field number must be updated
in the setup file.

The data mask in the settings.ini file must match the number of digits (e.g. 7 digits
equals ##HH).

You must use leading zeros.

Six or seven digits are recommended. The number of digits must be consistent within a
file. If you have one million or more, 7 digits is necessary.

Do not use the same unique identifier within a job, even if you split the file into multiple
segments.

The Data Mask is located under the [System] group in the Settings.ini file. See
“Configuration Files” on page 7-1 for a detailed explanation of this file.

IR Track

The IR Track System fits into your current continuous print operations or continuous
form bindery line. The system can be used to apply invisible automation marks or as a
method to add security information to printed documents. It can even be used to add sort
control marks to increase productivity. No database is necessary for the invisible print to
be appended.

]

The system reads preprinted unique identifiers and uses that information to print
invisible unique identifiers. Once printed, invisible identifiers can be read by




MCS Systems

Getting Started

MicroVision cameras. This results in printed pieces with no visible automation marks
that can now be matched.

L]
.
-
.
-
-
»
-
.
.
-
.
.

The system can mount on a continuous forms table or a forms Rewinder. The following
diagram shows the front and back view of a typical installation.

(- - E
= - - u

In a typical IR Track scenario, pages are printed 2-up with a trigger mark and a unique
identifier (such as a bar code) on opposite sides. The trigger/timing mark needs to be a

repeatable, detectable object that is the only thing that the sensor will detect within its
vertical path. The visible barcode is printed by your continuous laser printer. It is

i

@ User's Manual
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defined in your document-composition software (i.e., Anchor Max Designer, GMC
PrintNet). Both marks are placed in an area to be trimmed off later.

Visibla barcoda
Timingitrigger mark
[o] o]
b
o e L e
fratmsra—
o E. s BT Gos 0
- - e
o [yt = dey o 8 13m0 & (o]
o o
a R - o
N g e 5
— -
Q Q
e e, et e e 3t e e oy g oo o1k e, w0 e s
a [ iy s e — v oy e e e o
fopere e
& ety
Thw s i s g AN S LI e O D 0 a3 b e The e et T - © 8 WS SSOOMES I § e RO S e SRong o cee o
e e o o e 8 3 e 1 e e e et et 5 oo
o] PRy o v
o e = i e B srrer
e ey Tt o o e St i s S e e s . o P ok e e s e A 5
o e e L T T DI I T A
iy e B e et B SO e e e e e . e e et o s s}
a —r— ——r—— a
iy s b e e b e, i e s s i e 4 S e
o it piat- e At kb fotizast bt dsa bttt ey o
o e, b a
a [ S {laan Foole =]
O e . =
o] = o
a o

The visible barcode is defined as the combined values of the unique identifiers for both
records of the 2-up form. For instance, the name on the left may have a unique identifier
of “0000001”, while the name on the right side of the 2-up form has a unique identifier
of “0723001”. When concatenated together, the left and right side unique identifiers
would create the value “00000010723001”, which is created as the visible black barcode
in your trim area.

Unique identifier “0000001"

Unique identifier “0723001"
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The position of the barcode is dependent on the placement of your timing/trigger mark.
Generally, it is easiest if they are placed along the same horizontal plane. However, a
change in the physical placement of the trigger sensor can affect a change of the
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placement of the barcode, thereby changing the placement of the invisible barcodes on
the form itself. (The camera that reads the laser printed barcode is immediately triggered
by the sensor. Movement of the trigger sensor allows you to move the vertical placement
of the barcode.) When the timing/trigger mark is on the same horizontal plane as the
barcode, the equipment is set up as shown.

When the timingtrigger mark is on the same horizontal plane as the barcode, the equipment is set up

as shown.
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Understanding the relationship between the trigger sensor and the camera is vital to the
concept of how the IR Track system operates. Below is an example of what happens
when the physical placement of the trigger sensor is adjusted. You can print your
invisible codes lower on the form. You need to be cognizant of this placement, so that
you do not go too far, resulting in the invisible barcodes printing on the next/wrong

form.
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Determining the Distance from Sensor

Define the measurements that are required to print and verify the invisible barcodes.
What you see below is considered “Starting Position”. Jog your form to this position
(with the sensor directly over the timing/trigger mark). From here, measure the distance
from the beginning of the print head to the place on the form where you would like the
invisible barcodes to be printed. This is your “Distance from Sensor” value entered in
the I/O settings. See “I/O Settings” on page 4-6 for details.
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Defining Trigger Ticks Value

Measure the distance from the center of the camera (mounted behind the print head) to
the place on the form where you would like the invisible barcodes to be printed. This is
your “Trigger Ticks” value. (Be aware that the value cannot be greater than the length of
the form.) Trigger ticks are the value entered in the Settings.ini value as encoder ticks.
To define this value, calculate the number of encoder ticks time 300. So, the value
entered for encoder ticks with a 5.25 cycles would be 1575.
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Settings.ini

Settings.ini

Getting Started

MCS Input Camera System

This system decodes and passes data via serial or ethernet connection (e.g., 509 Caps
system as control of GBR Collator on the front of an inserter). Used in this way, the
camera decodes and then passes this information to another piece of equipment. The
camera has no control over the end use equipment.

When using the camera in this fashion, you must enter the camera settings in the
configuration file. For each camera, the following settings must be entered. The first
camera will have default setting. You can copy the lines and change the camera number
for additional cameras.

Camera. #.ComPort

Camera. #.PassResult
Camera.#.FailResult

Camera. #.ExternalDecodesOnly
Camera. #.BarCodeReadFormat
Camera. #.BarCodeNmChars

The Settings.ini file contains information specific to your system setup. While .cfg files
described in “Installing Special Files” on page 2-13 are created for you, the Settings may
require some manual configuration. All settings in the file must match your exact system
configuration. For example, the Exit Sensor number in the [System] group must match
the input number on the controller box. Certain items must be set in this file and cannot
be done via the software.

For Perfect Match, these items are:

e Data Mask

See “Perfect Match System Settings.ini” on page 7-1 for a detailed explanation of this
file.

In addition, you must also change the Key Field in the TCP/IP section of the
SetupMatch.cfg file to reflect the correct field number where the unique identifier is
located. If you do set this field you may get invalid comparisons or duplicates.

For IR Track, these items are:

» Distance.inches

e Double.Trigger.Inches

* Barcode.Num.Digits

e Trigger.Ticks

¢ Read.Mask

e Write.Mask

e Piece.Width.Inches

e Dist.From.Sensor.Inches
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Settings.ini

Getting Started

See “IR Track System Settings.ini”” on page 7-5 for a detailed explanation of this file.

@ User s Manual
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Chapter 3: Understanding the Interface

The MicroVision camera software is a Microsoft Windows-style
application. It is important to understand how the interface works
so that you may use the interface most effectively.

Opening the Application
The MicroVision camera software can be opened in many ways,
one of which is described here.
Note: Make sure your camera and dongle are connected prior to
opening the application.
To open the application:

1. Double click the MicroVision icon on your desktop.

Note: You may open the application using other Windows standard
techniques.




The Main Window

Understanding the Interface

The Main Window

Title Bar

The Main Window is the primary point of entry for all tasks. This window is broken
down into many areas as annotated below. Each area is described in the sections that
follow.

Title Bar

Menu Bar Toolbar Display Area

// / X
A we - H @

&
-

Exposure

Gain Orientation Trigger Decode

No camera selected

Name [ Tool Pass/Fall Result [Time [Score

1 cameras avaiable

Menu Bar

@ User s Manual

3-2

; : Results Area
Tab Selection Area Intensity Histogram

The Title Bar displays the name of the program, a minimize button, a maximize/restore
button, and a close button.

This standard Windows feature contains pulldown menus to select functions. Functions
which cannot be used appear dimmed (gray). Items in the Menu Bar are interactive.
They change as tabs are selected in the tab selection area.




Toolbar

Understanding the Interface

Toolbar
The Toolbar contains rows of iconic buttons that provide quick access to common tasks.
* Save
New — 1 o2 open - [ d @ <«— Run
ﬁ Open Add Camera
Customizing the Toolbar
The customize option allows you select which icons are shown in the toolbars.
To change icons displayed in toolbars:
1. Select Customize from the View menu and select the desired toolbar to change.
The toolbar window appears.
Customize Toolbar
Available toolbar buttons: Current toolbar buttons:
Separator ad L':E Add camera ad
@ Remove Camera Separator
P Camera properties I . Fiun
Q Camera zoom I:l
e Stop on erar _ V . i v
Text Selective text on right v
lcon Large icons v
2. Use the Add and Remove arrow buttons to change the icons displayed.
3. Click OK.
Display Area

The display area is the area in which functions appear. When you select a tab in the tab
selection area, the display area is repopulated with that information. You then work
within the display area to execute your tasks.

Tab Selection Area

The tab selection area contains three tabs: Camera, Log, and Run. Selecting a tab
changes the display area.

The Camera tab is described in detail in “Camera Operation and Setup” on page 4-1.
The Log tab provides a history of actions performed as well as errors and warnings. The
Run tab is described below.

@ User s Manual
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Tab Selection Area

Understanding the Interface

Run Tab

The Run tab provides status while the job is run.

2 MCS Perfect Match - *0CR Card.cjb

© File Camera Wiew Help

Dew @A

B On Line
Bl Read

B Cycle Sensor
I E it Sensor
B Cutput Sensor

I On Line
B Read

B On Line
B Read

[ Logging Active
Ci\Documents and
[ Data-File Present

B O Line
B Read

000EEE0

1 Eon Line B On Line
B Read 2 B Read 3
Con Line
. Printing
L Clear J [ Clear Blues ]

[ ]

Bun

Camera Lo

Camera 1 |Field 2 [Field 3

Field 4

0 cameras available

Read:

MM |
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Note:

You can also enable a Read and Print print job from the Run tab.

Lights show read activity and camera status. Printing status lights show if on and flashes
when printing. The registration sensor flashes once per cycle. The exit sensor flashes
when it is tripped. The output sensor flashes as well when it is tripped.

The Clear button physically clears all pieces on the list while Clear Blues clears pieces
only between the exit sensor and the printer. These option are not available for IR Track
systems.

When running, the table displays only those display columns that were requested during
I/0 settings configuration. See “I/O Settings” on page 4-6.
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Intensity Histogram

Understanding the Interface

The following table describes run colors.

Green Success

Red Failure

Yellow Duplicate Read

Pink Match so far - only pertinent with multiple cameras

reading the same image type.

Tan Invalid key. This may appear when what is passed to
the inkjet is not in the data file. It may be
misidentified in the data file.

Intensity Histogram

Results Area

Camera Zoom

The Intensity Histogram is located on the bottom left of the window. It shows the
intensity of dark and white spaces for the camera to read. It adjusts peak black and white
valley use as indicated by a dividing line that specifies one side of the line is black and
the other white.

The results area lists your current actions and details about those actions.

Name | Tool [ Pass/Fail [Result [Time [Score |
DM1_ [Data Matrix |Pass [476/2033) 0000547 032 |- |

Camera zoom, accessible via the View menu, increases or decreases the size of the
picture shown in the display area. It does not increase or decrease the actual picture
image.

New, Open, Save, Save As

Use these settings available in File menu to create, save, and open your current camera
settings.

@ User's Manual
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Debug Window

Understanding the Interface

Debug Window

To access most of the configuration files and troubleshooting files you need, press
CTRL-ALT-3. In addition to the files accessed via this window, you may also need to
click icons which are located on your desktop.

App Folder: C:\Program Files\MCS\PerfectiMatchl

Settings.ini ] l PrefectiMatchSettings. cfg ]

[
[ Open App Folder ] [ Connect to Debugger ]
[

Save Camera Image.., ] [ Load Camera Image. .. ]

[ Timestamp log
Debugging
[ClEnable Tolog []Tofile

[Nimages []Decodes

o) Loy
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Chapter 4: Camera Operation and Setup

Add Camera

Note:

This section explains how to add and configure your camera(s) as
well as how to review its operational status.

Once your camera(s) and software are installed you must add
your camera(s) to be recognized by the software. A camera can
be plugged in to the computer and the software may be open, but
the camera will not be recognized until it is added.

It is helpful to know the serial number of your camera(s) before
executing this procedure.

To add a camera:

1.

2.

Make sure the camera is properly installed and connected.

See “Camera Operation and Setup” on page 4-1. Note that the
bottom right corner of the screen indicates the number of cameras
available. This lets you know how many cameras are plugged
into the computer that have not been added to the software. After
you add a camera, the status reads 0 cameras available.

Select the Camera Tab.

L_Q 3. Click the Add Camera icon.

In This Chapter

Add Camera

Focusing the
Camera

Remove
Camera

Properties
I/O Settings

Running the
Auto Setup
Feature

I/O Timing
Run

Stop on Error
Decode Image

Reset Pass/Fail
Counts
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Add Camera

Camera Operation and Setup

The Add Camera Window appears.

O @ - @ @

Orientation Trigger Decode

Exposure Gain
Serial
Numbers
&
Intensity
Camers 4 Lon h_Aur 7
Ready
4.
5.
6.
@ User s Manual
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e frerar—2}-Pick a camera number, ) Click Assign.
Camera: | 287 hd

Camera Number

1
2
3

>0 Assign >>

Mame [Tool | Pass/Fail [ Rresult [Time [Scoe

Select the serial number for the camera you are adding.

1 cameras avalable

If you do not know the serial number of your camera, you can select any serial number
in the list and look at the installed cameras to see which one is flashing. If the desired
camera is not flashing, select another serial number until you locate the desired camera.

Assign a number to the camera.

You can assign any number to the camera. Multiple numbers are listed no matter how
many cameras you have installed. We recommend that cameras are numbered according
to placement on the inserter and not based on the order they were added. Select a

number and click Assign.
Click Exit.




Add Camera

The display area now shows the camera image.

Camera Operation and Setup

& MES Perfect Match - “Untitted

[BEI]

: Fle Camera  Wiew Help

D@ @O

s = =

1 Exposure Gain
3]

[E3]

R

Intensity

Mame [Tool | Pass/Fail [ Rresult
i
=

Orientation Trigger Decode

O External ®on
() Internal Q off

7,603

v

[Time [Scoe

0 cameras available

Saving Camera Setup

Tip:

o ok w

You can save the camera assignment by modifying the MicroVision camera

configuration file.

To save current camera settings:

Select Save from the File menu.

Provide a name for the file and click Save.
You can open this file the next time you use the software.

You can save the camera setup and have it reopen with this setup active the next time

you open the camera software. To do this:

Press CTRL-ALT-3.

The debug window appears.

Click the MicroVision Settings.cfg button.
A text window appears.

Modify the third line to equal 1.

Save the file.

Close the MicroVision camera software.
Reopen the MicroVision camera software

@ User's Manual
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Focusing the Camera

Camera Operation and Setup

Focusing the Camera

You can focus the camera by adjusting the camera lens position. This is done using the
set screw. It is important to follow the procedure below to ensure that the screw is not
dislodged and that no damage is done to the camera or lens during this operation.

To adjust camera focus:

1. Hold the camera straight and using the tool provided, insert the tool through the set
screw access hole into the set screw.

3. If you have successfully caught the set screw, it will turn no further. If your tool keeps
turning, you have not caught the set screw. Remove the tool and try again.

4. Once you have successfully caught the set screw, turn it a half turn counter-clockwise.

@ User s Manual
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Remove Camera

Camera Operation and Setup

5. You may now grab the lens with your fingers and turn it as needed.

6. When your adjustment is complete, return the set screw to the locked position. Make
sure you have correctly caught the set screw as in steps 1-3 before turning.

Remove Camera

This feature, accessible from the File menu, removes a camera that had been added. The
camera may remain connected to the computer, but it will not be recognized by the
software.

Properties

The Properties window, accessible from the Camera menu, provides status on the
currently selected camera. It tells you information such as the camera’s number and
serial number.

—
Camera Properties

Camera: 1

Serial #: 287

Firrmware wersion: 01:00:0368

Device path: WPUSE#Yid_O4b4aPid_0054#582Fh2Faa7aal #{cdshb75F1-de74-4a01-9

GUIC: {65738C70-26E2-4D00-308C-980024D66 166}

Framefsecond: 32.5

@ User’s Manual
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1/0 Settings

Camera Operation and Setup

I/0 Settings
The 1/0 settings window allows you to specify parameters about how the camera detects
pieces on the printer. It is especially important that your Cycles From Exit settings be
correct in this window to ensure proper setup.
The MicroVision Camera software can operate with an encoder to trigger the camera or
with a physical sensor. The I/O settings window displays different options, depending
on your setup.
To enter I/O settings on a system with an encoder:
1. Select I/0 Settings from the File menu.
1/0 Settings
Cameras: Diverter:
Cycles Delay
fromExit  (encader ticks) UUse Divert Function
Camera 1 | 13 1
Cycle Offset: | 12 {cycles)
Camera 2:
Delay: |0 (kicks)
Camera 3
Prinker: Stop Conditions:
[ 5top maching if read numbers are not sequential,
I:‘Enabled Erei:?:ltizﬂlljeer Piece Increment Value: | 1
Display Colurn 3: | 1 Stop machine if this many consecutive i)
; misreads occur {enter O to disable):
Bl Gt g Stop machine if this many consecutive 0
Display Column 5 | 3 mismatches occur {enter 0 to disable):
Desey oo+ B -
printed yet {enter 0 ko disable):
o) Coomr
2. Enter Cycles from Exit and Delay settings for each camera.
The number of cycles represents how many cycles of the machine are between the
camera and the exit sensor. Delay is the number of ticks in the cycle at which you want
the camera to be triggered for systems using an encoder.
For Flowmaster configurations, you can get the encoder ticks value from the timing
screen.
3. If you have a diverter, enter Diverter settings.
@ Users Manual
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Running the Auto Setup Feature

Camera Operation and Setup

Check the box to enable the diverter. When enabled, the cycle offset is always one less
than the primary camera’s cycles from exit setting (e.g., the camera’s cycle is 12, the
diverter setting is 11).

4. For Read and Print systems, enter Printer Settings.

When enabled, display columns are the fields in the data file that you want displayed in
the Run tab. These are usually the most important fields such as the unique identifier
field for camera decoding. See “Run Tab” on page 3-4 for a description of this tab.

5. Enter Stop Conditions.

Stop conditions are settings that you can define to stop the transport. They are used to
address any need for intervention. If the numbers are sequential and you want to verify
this order, check the Stop machine if read numbers are not sequential check box. This
action is helpful to double check that there are no missing pieces. 1 indicates a high to
low read and -1 indicates a low to high read. If they are not sequential, this feature is not
applicable.

Stop Conditions:

[15top maching if read numbers are not sequential,
Piece Increment Value: | 1

Stop machine if this many consecutive i)
misreads occur {enter O to disable):

Stop machine if this many consecutive 0
mismatches occur {enter 0 to disable):

Stop machine if this many pieces have
passed the Exit sensor but have not been
printed yet {enter 0 ko disable):

5

It is particularly helpful to use this feature with OCR data. Be sure to check the box
when running sequential OCR data.

Misreads and mismatches have values of O for off. Enter a threshold of misreads before
a stop. This field may also be used when there is no diverter.

Mismatch is used when multiple cameras are being used to tell the system to stop when
values are not equal from one camera to another.

When using a printer, the number of pieces indicates how many pieces can go past the
exit sensor without reaching the actual printer before printing will stop. This setting can
avoid a pile up at the print head. These are identified as blue lines on the Run tab. The
number entered is the maximum load plus one. For example, if the physical number of
pieces that fit is 5, the number entered is 6.

Running the Auto Setup Feature

You can also set the cycles and delay settings via the Run tab. This provides accurate
setting for these fields but can’t be done until you have installed everything else and
configured a readable image. Its important to optimize these settings so that the exit
sensor alerts at the proper time.

To get the settings:

1. Click the Run tab.
2. Press CTRL-ALT-3.
3. Click Settings.ini.

@ User s Manual
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1/0 Timing

Camera Operation and Setup

4. Go to the System group and on the first line change Setup Mode to 0. Save the file.
Save any current Camera software settings.

Close the Camera software.

Reopen the Camera software.

No oo

The cycles and delay information in the I/O Settings window has been updated.

I/0 Timing
When pieces are running, you can look at this screen to view timing status. To display I/
O timing status, select I/O Timing from the File menu. If printing, an acknowledgement
can also be included.
PerfectMatch Timing Dialog:
Code |Cycle [Exit [Qutput [Camt Trig [Cami Rd [Camz Trig [Cam2 Rd [€ama Trig [Cam3Rd [Prrt Ack |Spare
Run

The Run feature, accessible from the File menu, takes the camera in and out of decode
mode.

Stop on Error

When enabled, this feature, accessible from the File menu, displays the errored image on
screen. The Clear Stop Error removes the image from the screen. This is useful when
reading OCR characters. It can help identify all characters that need training.

@ User s Manual
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Decode Image

Camera Operation and Setup
Decode Image

When a tool is selected, you can use this option from the Camera menu to decode the
image.

Decode on Tool Update

When enabled, images are automatically decoded when updates are made to the tool.

Reset Pass/Fail Counts

This feature resets the Pass/Fail counts displayed in the Results table for each tool.
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Reset Pass/Fail Counts

Camera Operation and Setup
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Chapter 5: Readable Image Types

The MCS MicroVision camera software reads Data Matrix In This Chapter
barcodes, linear barcodes, and OCR alphanumerics. It is
recommended that you read The Bar Code Book by Roger C.
Palmer (ISBN 0-911261-13-3) to gain a comprehensive
understanding of bar codes. The items in this section pertain to
readable image type descriptions with regard to the MicroVision

* Printing and
Converting
Issues

* Understanding
the Camera Tab

camera.
» Data Matrix
Barcodes
Printing and Converting Issues « Linear
Barcodes
When using either barcodes or OCR alphanumerics, it is + OCR
important to realize that the print quality from your laser printer Alphanumerics

and your conversion process quality are critical for successful
reads with the matching system.

When you start printing a job with your laser printer, make sure
you incorporate quality control procedures regarding the barcode
or OCR alphanumerics. Look for erroneous printing of dots or
fuzzy printing. If the entire run is produced with faulty barcodes
or OCR alphanumerics, there is little you can do to make it work.

When the document is converted (cut and/or folded), it is critical
that the cut and fold be identical on every form. The camera is
looking at one spot to read the data, and if the pieces are folded
even slightly differently, the image will not be properly decoded.

Understanding the Camera Tab

The Camera tab provides access to the camera image, readable
image tools, and image refinement settings.




Understanding the Camera Tab

Readable Image Types

@ User s Manual
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Image Tools

Image tools decode the image that the camera sees. To configure how the tool decodes
the image, click on that tool’s icon.

OCR

Once the tool has been configured, you can modify the tool setting by clicking the Tool
Properties icon. Configured tools are listed in the tool Results area. When a tool is
correctly reading an image it is displayed white with Pass text and when it is not, it is red
with Fail status.

Name | Tool [ Pazs/Fail [Result [Time [Score
D1 |Data Matriz |Pass (476/2033) 0000547 03.2

Mame | Tool Pass/Fai Result Time | Score

You can also access the tool’s configured settings by double-clicking the tool’s row in
the tool result area. To remove a tool, click the Remove tool icon. The Blue Rectangle
tool allows you to narrow the readable area from the full screen to size of the blue box.
This helps the camera software ignore the extra noise, thereby increasing decode speed.

Il
I
O

Image Refinement Settings

The image refinements settings (exposure, gain, orientation, and trigger) adjust the
clarity of the image displayed. Expose adjusts the amount of light allowed in. Gain
adjusts the contrast based on the amount let in. It is best to leave the Exposure a bit
lower and raise the Gain if possible. Be careful not to adjust the gain too high. This will
produce a grainy image.

Exposure 3ain Crienkation Trigger Decode
15 = 1 = 0 deg. m () External ®on
(] (] B8l (%) Internal O off




Data Matrix Barcodes

Readable Image Types

Orientation adjusts the rotation of the image. OCR requires that the image is read left to
right. It does not matter for other image types. The capture below shows an image after
image refinement has been performed.

2 MCS Perfect Match - *Untitled
Fie ra Vew Hel

St &
£ Tk
_ | E
Nare [Tool [PassfFsl _[Rew [Time [5¢
%J DM1 | Data Matin | Pass [345/0] | DU001710006213 | 07.0
Tntensiy <

The trigger can be set to External, which detects actions from the machine, or Internal
from the software, which executes consecutive firing.

In production mode, the trigger mode must be set to External. Decode must always be
On in production mode.

Data Matrix Barcodes

Data Matrix Barcode Template Placement

The following items provide some specifications for how to place data matrix bar codes
in the MCS Printer software template.

o Size>=V, <=1"

*  Cell Size <=12 cells

*  DPI>=300 dpi

* Clear Zone - an area surrounding the image that has nothing but white space

The clear zone must have no other print in area.

The Data Matrix barcode can be printed anywhere that the camera can see it on the
inserter. The data in the data matrix barcode should be only the unique identifier.
Leading zeros are required to give the barcode a uniform size though out the job.

@ User's Manual
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Data Matrix Barcodes

Readable Image Types

Data Matrix Symbol Sizes

6 3 10x 10
10 6 12x12
16 10 14x 14
24 16 16x 16
36 25 18x 18
44 31 20 x 20
60 43 22x22
72 52 24x24
88 64 26x26
124 91 32x32
172 127 36x36
228 169 40 x 40
288 214 44 x 44
348 259 48 x 48
408 304 52x 52
560 418 64 x 64
736 550 72x 72
912 682 80 x 80
1,152 862 88 x 88
1,392 1,042 96 x 96
1,632 1,222 104 x 104
2,100 1,573 120 x 120
2,608 1,954 132x 132
3,116 2,335 144 x 144
10 6 8x 18

20 13 8x 32

32 22 12x 26
44 31 12x 36
64 46 16 x 36
98 72 16 x 48

Data Matrix Barcode Tool Configuration

The way the camera decodes the Data Matrix barcode image is configured via the Data
Matrix Image tool.

To configure Data matrix readability:

1. Click the Camera tab.

@ User s Manual
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Data Matrix Barcodes

2.

Note:

Readable Image Types

Click the Data Matrix tool.
The Data Matrix Tool Properties window appears.

Data Matrix Tool

Mame:
Decode timeout: | s0 (milliseconds)

Masking

Mask: | ####%%
Fixed length: & {derived fram mask)

Test: | 123456

Result: | 123456

Matrix size: |10 10 -

[ ¢alculate light on dark

O Darkon light (%) Light on dark

Threshold ... Fixed: 14

Log reads Cutline read

[ ¢aloulate grade [ 5how threshold image

[ OF ] [ Apply ] [ Cancel

If desired, enter a name for this configuration.

If you do not enter a name, a name will be provided for you.

Enter the decode Timeout.

The decode time sets how long the camera is given to read the image before a misread is
reported and the camera moves on to next image. Typically this is left at 50 seconds. The
number should never be increased over the speed at which you are running. For

example, if you are running at 10,000, the number should not be more than 100 (1/10000
equals .0001 which equals 100 ms).

Review the Character Length.

This sets how many digits are in the unique identifier. Enter the correct amount of pound
signs to match the number of digits in the unique identifier field. You can use symbols
such as (-) or (A) to skip or replace a digit. In the Test field, enter numbers equaling the
required digits to test that the correct amount of pound signs have been entered. The
results field will display what will be read if the test numbers were decoded. ##### with
test data of 12345 will display 12345 in the results field; while A#### will display
A2345 and #-### will display 1345.

Enter the Matrix size.

Do not use the Automatic setting. Select the correct size. To find the correct size,
count the number of black and white spaces for length and width, See “Data Matrix
Barcode Template Placement” on page 5-3 above for explanation on bar code sizes.
Enter Calculate Light on Dark settings.

Dark on light is used for visible barcodes. Light on Dark is used for invisible barcodes.
Invisible barcodes require the use of the invisible barcode camera.
Click Threshold.

@ User s Manual
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Linear Barcodes

Readable Image Types

10.
11.

Note:

Linear Barcodes

I

@ User s Manual

The Threshold window appears. This window brings up the camera image and allows
you to adjust the black areas outside of the image.

Threshold

) Adaptive global
() Adaptive local
(& Fixed | RS

T T i
DM1__ Diata Matrix_| -~ [070]
< | >

The Adaptive Global, Adaptive Local, and Fixed settings allow you to adjust the amount
of black and white space displayed around the image. Adaptive Global adjusts the circle
around the image to the maximum image allowed by the camera. Local reduces the area
closest to the image. Fixed allows you to manually adjust the area and is the most
commonly used format.

Click OK.
Check additional options.

Foint: | 280, 469 |

Intenisty: | 124

N

2 cameras available

Enter Threshold settings.

You can enable Log reads to enter data in the log file. Checking Outline Read places a
green outline around the image based on your threshold settings. You can show the
Thresholds settings and you can enable the Calculate grade option. The Calculate grade
option provides a score on barcode matching.

Do not check Calculate grade while the job is running. This is will slow down
performance.

Some Linear barcodes may not fit in the field of view of the camera. The typical field of
view is 1.25 inches. If the bar code is larger than 1.25 inches, the camera can not read it.
Linear barcodes are configured in similar fashion to Data Matrix barcodes.
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Linear Barcodes

Readable Image Types

To configure Linear barcode readability:

1.
2.

Note:

Click the Camera tab.
Click the Linear Barcode tool.
The Linear Barcode Tool Properties window appears.

Linear Bar Code Tool

Mame: | LNi
Decode timeout: | 50 (milliseconds)

Masking

Mask:

Test: _- 1234567590123456759012345675901 i

Result: | 1234567890123456789012345678901

Bar code bype: | mME b

[ ¢alculate light on dark

(& Dark on light () Light on dark

Threshold ... Fixed: 187

Log reads Outline read

[ 5how threshold image

[ OF H Apply ] [ Cancel ]

If desired, enter a name for this configuration.

If you do not enter a name, a name will be provided for you.

Enter the decode Timeout.

The decode time sets how long the camera is given to read the image before a misread is
reported and the camera moves on to next image. Typically this is left at 50 seconds. The
number should never be increased over the speed at which you are running. For

example, if you are running at 10,000, the number should not be more than 100 (1/10000
equals .0001 which equals 100 ms).

Review the Character Length.

This sets how many digits are in the unique identifier. Enter the correct amount of pound
signs to match the number of digits in the unique identifier field. You can use symbols
such as (-) or (A) to skip or replace a digit. In the Test field, enter numbers equaling the
required digits to test that the correct amount of pound signs have been entered. The
results field will display what will be read if the test numbers were decoded. ##### with
test data of 12345 will display 12345 in the results field; while A#### will display
A2345 and #-### will display 1345.

Select the barcode type form the list.

Enter Calculate Light on Dark settings.

Dark on light is used for visible barcodes. Light on dark is used for invisible barcodes.

Invisible barcodes require the use of the invisible barcode camera.

@ User s Manual
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Linear Barcodes

Readable Image Types

8. If a checksum characters appears with your barcode, enable the Checksum Character
feature.

9. Click Threshold.
The Threshold window appears. This window brings up the camera image and allows
you to adjust the black areas outside of the image.

Linear Bar Code Threshold

—F
]

Threshald Point: | 256, 480

(%) Adaptive global
() Adaptive local

Inkenisty: ==

o (o] N

10. Enter Threshold settings.
The Adaptive Global, Adaptive Local, and Fixed settings allow you to adjust the amount
of black and white space displayed around the image (and is the most commonly used
format). Adaptive Global adjusts the circle around the image to the maximum image
allowed by the camera. Local reduces the area closest to the image and Fixed allows you
to manually adjust the area. The Line intensity graph tells you to draw a line completely
through the image. It then displays the intensity highs and lows. Keep drawing lines
until you end up in the middle to achieve the best readability.

11. Click OK.

You can enable Log reads to enter data in the log file. Checking Outline Read places a
green outline around the image based on your threshold settings. You can show the
Thresholds settings.

@ User s Manual
5-8



OCR Alphanumerics

Readable Image Types

OCR Alphanumerics

12345

Note:

The camera can decode OCR alphanumerics. You must train the software to read the
numbers properly. This may take some time, as for each job each character must be
trained.

The OCR alphanumeric must be read left to right. You can change the orientation of the
camera image via “Image Refinement Settings” on page 5-2 to ensure proper
readability.

OCR Alphanumerics Template Placement

The following items provide some recommendations for how to place OCR
alphanumerics in the MCS Printer software template.

* Size>=6pt<=8pt

¢ Font OCR A, or OCR B

«  DPI >=300dpi

e Clear Zone - an area surrounding the image that has nothing but white space.

Although the MicroVision camera software can learn many fonts for OCR, we
recommend standardizing on OCR A or B, since they are Fixed Pitch Fonts, rather than
Proportional Pitch Fonts. Fixed Pitch means that each character is the same size
(particularly width), which is necessary for a uniform identification of OCR. It is
recommended that the software be standardized on a seven digit number to avoid
duplicate printing. All numbers should have leading zeros, for example, “0002456”.

OCR Alphanumerics Tool Configuration

The OCR Alphanumerics tool allows you to configure how the camera decodes the
OCR image. You can save the trained characters and use them for similar jobs.

To configure OCR alphanumerics:

Click the Camera tab.

Click the OCR Tool icon.

A message appears asking you if have existing configurations.

Click Yes to select from a list of existing setups or No to create a new setup.

@ User s Manual
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OCR Alphanumerics
Readable Image Types

@ User s Manual

If Yes, a list of existing setups appears. Select the desired item from the list and click
OK. If No, a Save dialog appears requesting a name for this file. Provide a name, click
Save, and proceed with the steps remaining in this procedure.

Marne: | SIS

Decade timeout: | 50 |(ms)  Minimurn score: | 50 «|

L5rl]
Masking
Mask: | ##aesees

Fixed length: &

Test: | 12345678

Result: | 12345678

Threshold. .. Threshold: 128

QiR Font

File: | :er\DesktoptCamera JobsiOCR. cfb Mew, ..
# [ Char [Glyph [width [Height |
Delete selection. ..
- *Changing any OCR font
Train | Decode. .. parameter effects all OCR tools

immediatly,

Log reads CQutline read

[ 5how threshold image [ outline blobs
[ 5how characker images
.

Enter the decode Timeout.

The decode time sets how long the camera is given to read the image before a misread is
reported and the camera moves on to next image. Typically this is left at 50 seconds. The
number should never be increased over the speed at which you are running. For
example, if you are running at 10,000, the number should not be more than 100 (1/10000
equals .0001 which equals 100 ms).

Review the Character Length.

This sets how many digits are in the unique identifier. Enter the correct amount of pound
signs to match the number of digits in the unique identifier field. You can use symbols
such as (-) or (A) to skip or replace a digit. In the Test field, enter numbers equaling the
required digits to test that the correct amount of pound signs have been entered. The
results field will display what will be read if the test numbers were decoded. ##### with
test data of 12345 will display 12345 in the results field; while A#### will display
A2345 and #-### will display 1345.

Enter Calculate Light on Dark settings.

Dark on light is used for visible barcodes. Light on dark is used for invisible barcodes.

Enter the Minimum score.
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OCR Alphanumerics

Readable Image Types

OCR is the comparison of the trained shapes to the shapes the camera picks up on the
image. No image will match trained characters 100% due to general printing
imperfections; therefore, a minimum score is used for comparison. 70% is the
recommended minimum score.

Click Threshold.

The Threshold window appears. This window brings up the camera image and allows
you to adjust the black areas outside of the image. For OCR images you need to
configure blob settings.

Click Outline Blobs.

There may be some background images close to or surrounding the actual numbers.

OCR Threshold X

Threshold: 1z8 2 Paint: | 197, 475 |

10 blobs in 1.5 ms [ outline ocr e | 159 |

9 chars in 20,6 ms ' :

&) o] §
@ User’s Manual
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OCR Alphanumerics

Readable Image Types
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OCR Threshold

O00E2HE

Threshald: 1z8 2 [ outiine blabs Paint: 87, 471
10 blobs in 1.5 ms o] Intensity: 105
9 chars in 20,5 ms

*apply MNow*
o Cem N

Note:

10.

11.
12.

13.
14.

You can also use the blue rectangle later to narrow the visible area and eliminate blobs.

Enter Threshold settings.

Reduce the numbers until the actual OCR is readable but not distorted.
Click OK.

Use your arrow keys to highlight a question mark in the read field.

The alphanumeric pertaining to that position flashes.

To train, enter the number you wish the flashing item to be recognized as.
Click Train.




OCR Alphanumerics

Readable Image Types

Outlines turn green when trained. Alphanumerics should only be trained one time, even
if they appear multiple times in a particular image. Multiple training of alphanumerics
will slow down processing.

2 MCS Perfect Match - OCR Card.cjb

: File  Camera Wiew Help

D QOpenv@.

Exposure ps Fain

Orienkakion Trigger Decode

(&) External & on ‘ 2 3 4 8
100 = 15 = g
I—"I g |Ddeg—VI (O Internal O off | 1
A~

000E2HE

Intensity

Camera 4 Log _Run /

Paszs/Fail
| Pass [415/626)

0CR1 |OCA | D00E242

[
|

0 cameras available

MM

15. Repeat this recognition (steps 1-14) for every alphanumeric needed.

This may take some time. Trained numbers are listed in the table. You can delete and

retrain items as needed.
16. Check additional options.

You can enable Log reads to enter data in the log file. Checking Outline Read places a
green outline around the image based on your threshold settings. You can show the
Thresholds settings and you can enable the Calculate Grade option. The calculate grade

option provides a score on barcode matching.

@ User's Manual
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OCR Alphanumerics
Readable Image Types
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Chapter 6: Troubleshooting and Maintenance

The following sections can help you troubleshoot printing In This Chapter
problems. The troubleshooting tables below can help you identify Software
common problems. Diagnostics
When problems occur, MCS asks that you run the Debug utility  |* M.achine :
Diagnostics

prior to contacting technical support. This will help us more
quickly identify the problem and provide a solution.

Software Diagnostics

A variety of diagnostics tools are available through the
Diagnostic interface accessed via CTRL-ALT-3.

App Folder: C:\Program Files\MCS\PerfectiMatchl

[ Settings.ini ] l PrefectiMatchSettings. cfg ]

[ Open App Folder ] [ Connect to Debugger ]

[ Save Camera Image.., ] [ Load Camera Image. .. ]

[ Timestamp log
Debugging
[ClEnable Tolog []Tofile

[Nimages []Decodes

o) Loy

Configuration Files

You can access the configuration files used to make advanced-
level changes to software operation.

Camera Images

You can save and load the images to help isolate specific
decoding issues.
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Machine Diagnostics

Troubleshooting and Maintenance
Debug Utility

To run the Debug Utility:

1.  With the camera software open, press CTRL-ALT-3.
The Debug window appears.

2. Click Connect to the Debugger.

Minimize the spy window.

4. Click Connect to Debugger a second time.
Debug information is placed in the spy window.

5. E-mail debug information to technicalsupport@mcspro.com.

w

Machine Diagnostics

This feature tests for printing and camera operation.

Note: Swing arm operation is not supported in this feature.

To enter 1/O test:

1. Select I/0 Test from the File menu.

1/0 Test

Controller Yersion: 7727

Transport is: NOT RUNNING

Activate Divert
Activate E-Stop
Test Setial Connection | COM1

Trigger Camera 1 vl

2. Select one of the desired testing operations.

Activate Diverter ~ Activates the diverter station to test if misreads are
being sent to the bin. This helps verify that system
keeps running even when errors occur.

Activate e-stop Activates e-stop to verify proper operation.

Test serial

Establishes a connection to verify connectivity.
connection

Trigger Camera Test fires the camera through the controller to verify
connectivity.

@ User s Manual
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Chapter 7: Configuration Files

The following tables describe each line of the settings file for a variety of MCS systems.

Perfect Match System Settings.ini

[System]

System-level settings

Setup Mode=0

Used to set up the machine with the software.

Encoder Present=1

1 is used for an external encoder. 0 if you were using collars for the cycle and
encoder tics.

Encoder Reset Sensor=4

Encoder Reset is used when installing an external encoder such as the one used
on the MCS inkjet (RSI). This gives the encoder a starting point, which resets
with a collar sensor.

Encoder StartStop Msecs=500

Tells the encoder when to reset when using an external encoder such as a flow
master.

Cycle Trigger Ticks=0

Used for the centering of the Exit sensor in a given cycle. Resets the zero point.

Cycle Sensor=0 ;0=Encoder-triggered

Cycle comes from a 0 (encoder) or a 1 collared sensor (Trigger) .

Exit Sensor=1

Used to calculate your cycles. You may also change where your input would
be. The exit sensor can be put in any of the four inputs on the IO box. You just
need to change the number. This must match the physical input number on the
controller.

Output Sensor=2

The output sensor is used to catch a missing piece after the exit sensor. If there
is no piece, the system will shut down. This must match the physical output
number on the controller.

Data Mask

Data Mask tells the application how many characters there are in the field being
read. It always needs to have the correct number of pound signs. You can not
have any less or any more then the number. You can replace the pound signs to
other characters. (#)-means I'm reading, If you replace the pound sign with a (-
) this means read it, but ignore that digit. For example, if you have six digits in
your OCR or 2D and your data only has five ,you may also replace the pound
signs with Alpha. If your barcode is (123456) use six pound signs. If your data
is (A23456), the first pound sign can be change to ignore the one and replace
with an A

Data Trim

This is used to remove information. If you put a zero in the quotes, all zero's are
removed from the code.

Sensor Invert Bitfield=00000001

Not used.

Sensor Active Polarity=00000000

This is to reverse the Polarity on your sensor to light or dark. (Leading edge -
Trailing edge) The zeros represent the amount of inputs on the controller. The
input you want to change determines which zero to change. Starting from the
right is number one.

Misread Trigger Count=0

This is in your IO Settings box so that you may stop the machine after the
specified number of Misreads. Change the count to the desired number. One is
normal.

7-1



Perfect Match System Settings.ini

Configuration Files

Mismatch Trigger Count=0 This is in your IO Settings box so that you may stop the machine after a
Mismatch. One is normal.

Print Que Len Trigger Count=5 Shows how many blues are between the exit sensor and the print sensor. If there
are too many, you could possibly go out of order. Show to little and you receive
and error (Max Number of blues between sensors).

Enforce Sequential Reads=0 Turns on or off your Sequential read. (1 is on 0 is off)

Sequential Increment=1 One reads low to high and a negative one reads high to low.

Ignore Leading Cam Reads=1 Used mainly on a swing arm inserter using collars for its signals, triggers a
cycle sensor before your camera.

Ignore Exit Sensor on Encoder Stop=1 Tells the machine to ignore the exit sensor when it stops. The eason for this is to
help with the blue over green.

Dupe Checking Enabled=0 Zero is off, one is on.

Enable Output Check=0 Zero is on, one is off. This is the sensor that is placed at the end of the inkjet so
that we can capture missing pieces.

Output Clear On Stop=0 Zero is off, one is on. This tells the output sensor to clear its count after the
machine is stopped.

Trigger Variance=0.4 A percentage for the out put sensor. Tells the output sensor that fourty percent
of the time the space between pieces is correct. This number can by changed.

Cam Read Variance=0.05 Gives the camera a five percent window to help handle missing and or double
triggers when running the camera underneath the feeder.

Auto Print Mode=1 ;0=Never,1=On Cycle,2=On Tells the printer when to go into print mode.

Encoder Start

[Selective Inserting]

Used with a data file to indicate one of three hoopers to be pulled at random.
Only with hoopers 4,5,6 at this time on a flowmaster.

Enabled=0

Enabled = 1 and zero= off

Polarity=0

Polarity is the revers of the signal. (just like light or dark)

Pre-Data Delay=5

Latch Pulsewidth=10

Post-Data Delay=5

Pre-Data Delay, Latch Pulse Width and Post-Data Delay are all measured in
milliseconds. These should not be played with unless you have a scoop
available for use. These measurements are put in to send a certain length signal
to the machine.

Feederl Field =6

Fields can be changed to indicate what field to read the data from. The fields
just need something like the word feed in it, and you need three fields one for
each feeder.

Feeder number will indicate which feeders are to be selective. This will also
need to have the wiring onto the correct location. Surefeed will need to add a
input module an software to the flowmaster.

Feeder2 Field =7

Feeder3 Field =8

Feederl Number=4

Feeder2 Number=5

Feeder3 Number=6

[Sensor Debounces] These settings really should not be adjusted unless you have a scope hooked up
for your readings, but you can use these settings to help handle noise in the line.
Sensorl Debounce Count =50 ;Exit Sensor
Sensor2 Debounce Count =0 ;Output Sensor
Sensor3 Debounce Count =0 ;Spare Sensor
@ User s Manual
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Perfect Match System Settings.ini

Configuration Files

Sensor4 Debounce Count =0 ;Encoderl "Sync"

signal

Sensor5 Debounce Count

=100 ;Cameral Trigger

Sensor6 Debounce Count

=100 ;Camera2 Trigger

Sensor7 Debounce Count

=100 ;Camera3 Trigger

Sensorl Debounce Count Source = 1 ;0=>Encoderl
ticks, 1=>Milliseconds

Sensor2 Debounce Count Source = 0 ;0=>Encoderl
ticks, 1=>Milliseconds

Sensor3 Debounce Count Source = 0 ;0=>Encoderl
ticks, 1=>Milliseconds

Sensor4 Debounce Count Source = 0 ;0=>Encoderl
ticks, 1=>Milliseconds

Sensor5 Debounce Count Source = 1 ;0=>Encoderl
ticks, 1=>Milliseconds

Sensor6 Debounce Count Source = 1 ;0=>Encoderl
ticks, 1=>Milliseconds

Sensor7 Debounce Count Source = 1 ;0=>Encoderl
ticks, 1=>Milliseconds

[Camera 1] Information provided for this camera is applicable to all three cameras.
IP=localhost IP address will always be localhost, because of the USB connection.
Enabled=1 Enable = 1 zero is off. This may be done in the software.

Cycles From Exit=13

Cycle from exit depends on where your camera is positioned.

Trigger Source=0 ;0=encoder,5=Trig-1,6=Trig-2,etc.

Trigger source is asking how the camera fires, encoder or external. Zero =
Encoder Input 5,6 or 7 could be used for external trigger such as a swing arm
inserter and also under a feeder on a flowmaster. Five being camera one, etc.

Trigger Tick Count=1

This is where you use your encoder tics to tell the camera when to fire. This is
the delay setting in the I/O settings screen.

[Camera 2]

IP=localhost

Enabled=1

Cycles From Exit=11

Trigger Source=0 ;0=encoder,5=Trig-1,6=Trig-2,etc.

Trigger Tick Count=1

[Camera 3]

IP=localhost

Enabled=1

Cycles From Exit=9

Trigger Source=0 ;0=encoder,5=Trig-1,6=Trig-2,etc.

Trigger Tick Count=1

[Printer] Only use the MCS Array.

IP=localhost IP address could be local or a specific address if using more then one PC.
Enabled=0 Enable isone=on  Zero = off

Port Number=700 Port 700 is our TCP/IP connection

@ User's Manual
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Perfect Match System Settings.ini

Configuration Files

Field1=1 Fields 1,2,3 and 4 can be change to any field you would like to view in the
software.

Field2=2

Field3=3

Field4=4

[Diverter] Diverter has a couple of functions.

Enabled=1 Enable = one means on and zero = off.

Output=1 The diverter can be hooked up to any of the outputs. We would like to keep this
uniform, so if you would please try and leave it on output one.

Cycle Offset=12 Cycle Offset = one less then the primary camera.

Delay Source=0 ;0=encoder,1=millisec timer Delay Source is decided by Encoder Tics (zero) or in milliseconds (one) Once

Delay Ticks=0 you have decided that then you may choose which delay to use (Delay Tics or

- Delay Time) Delay Ticks refers to the ticks setting on the I/O settings window.
Delay Time=0.0

[I/O] 10O helps you display a comm port, com band and the e-stop output. The comm
port can be changed. The e-stop can be also changed to any output that is not
being used. We would please like everyone to keep this uniform.

Comm Port=1
Comm Baud=115200
EStop Output=2

[Log] The log section is activated when you start the software. To turn things on you
need to use a one to turn them off use a zero.

Folder=C:\
Date-Time Format="%m%d%y-%H%M%S"

;log?, e-stop?, trigger count, log code, log text, EStop
Message

App Open =1,0,1,A,Program Start
App Close =1,0,1,B,Program End

Transport Stop = 1,0,1,C,Transport Stop

Transport Start = 1,0,1,D, Transport Start
Piece Fail = 1,0,1,E,Piece Fail
Piece Success = 1,0,1,F,Piece OK

Piece Removed = 1,0,1,GPiece Removed

Duplicate Piece = 1,0,1,H,Piece Duplicated
Invalid Key = 1,1,1,I,Invalid Key

[Debug] You can use this to trouble shoot the system.
Enabled=1

Debug Filename=

Show Timestamps=1
Mask=-1

@ User s Manual
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IR Track System Settings.ini

IR Track System Settings.ini

Configuration Files

[System]

Encoder.Ticks.Per.Inch =300

This is the unit of measure that the system will use; It will always be set to 300.

Run.Screen.List.Len =32

Represents the number of lines you want to view on the Run Tab.

Setup.Mode =0 Disables all EStops and their Dialogs

Password =MCS

Time.Stamp.Ratio =0.05

[Registration Mark]

Distance.Inches =14 Represents the distance between registration marks on your form; it is generally

the size of your form (11" form, 17" form, etc.).Distance between registration
marks.

Required Manual Setup

Double.Trigger.Inches =13

Represents the distance you want surveyed for double detection; if the trigger
sensor is tripped this value (X) or less from the last trigger, it will send a E-Stop
signal to the rewinder, indicating a "Double Detect". This usually indicates that
the sensor has been triggered by something in addition to the registration mark.
This value is always entered as 1 inch smaller than the Distance.Inches value.
;EStop if mark detected this distance or less from previous.

Required Manual Setup

Missing. Trigger.Count =2

Indicates the threshold for the number of registration marks that can be missed
before an E-Stop signal will be sent; the system monitors the number of
encoder ticks that have occurred since the last trigger -- if the value reaches
Missing. Trigger.Count times the Encoder.Ticks.Per.Inch, then an error pops up
on screen indicating that X number of forms have passed without seeing a
registration mark. ;EStop if this many successive registration marks missed.

[Camera 1] Read Camera

Trigger.Ticks =0 A delay mechanism for tripping the camera. It uses encoder ticks as a unit of
measure. This value is recommended to always stay at 0. ;Trigger camera N
encoder ticks after registration mark.
Required Manual Setup

Barcode.Num.Digits =14 The number of characters or digits that the barcode in your trim area represents.

For instance, if the barcode was created from a 16-digit number, then you
would enter 16 on this line. ;Number of digits encoded in laser barcode.

Required Manual Setup

Derive.Misread.Barcodes =1

This line item lets the IR Track software determine the next barcode in
sequence, in case it doesn't actually read it. The value is either 1 (On) or 0 (Off).
This can only be used when the Trim Area barcodes (printed by your laser
printer) follow a pattern. If the numbers are in random order, then this function
must be turned off (0). ;Derive barcode if camera misreads .

Derive.Sample.Len =3

The threshold number of barcodes that need to be read successfully AND in
succession, to determine the pattern for the derive function. Any value less
than 3 is not recommended. ;Verify sequence for this many pieces before
allowing derives.

Misread.Trigger.Count =5

The threshold number for missed or derived Trim Area barcodes to occur
before an E-Stop message is sent ;EStop if this many successive misreads/
derives occur.

[Camera 2]

Verify Camera 1

@ User's Manual
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IR Track System Settings.ini

Configuration Files

Enabled =1

Value is either 1 (on) or 0 (off).

Trigger.Ticks = 2400

This value is the distance that your continuous form will travel after the Trigger
Sensor is tripped until the Verify (Invisible) camera will fire. It is measured in
Encoder Ticks (unit of measurement is always 300). To determine this value,
you measure the distance with a ruler, and then multiply that number by 300.
This value can NEVER be greater than the distance between registration marks.
;Trigger camera N encoder ticks after registration mark.

Required Manual Setup

Read.Mask = i

This entry is to define the characters that you want to compare from Camera 1
successful read. A # sign indicates that the character located at that position in
the string is to be used for comparison. A “-” sign indicates that the character
located at that position is to be ignored during comparison. In this example, the
first 7 characters are the only ones to be considered for matching status, while
the last 7 are being ignored.;#=copy digit, -=skip digit, other=replace digit.

Required Manual Setup

Write.Mask = HHHH

This entry is to define the number of characters to be compared for matching
purposes. The number of "#" signs must equal the number of "#" signs defined
in the Read.Mask line above it. ;#=copy digit, other=replace digit.

Required Manual Setup

Misread.Trigger.Count = 5

Defines the threshold of consecutive misreads before a stop signal is to be sent
to the system. ;EStop if this many successive misreads occur

Fire.Sequence =1010101010101010 Defines the pattern at which the Verify camera will occur. This is ALWAYS 16
characters in length. In this example, the first piece will be verified, the second
is not, the third piece is verified, etc., etc., etc.... ;1=Fire, 0=Skip Piece (16
digits)

[Camera 3] Verify Camera 2

Enabled =1

Trigger.Ticks = 2400 Trigger camera N encoder ticks after registration mark.
Required Manual Setup

Read.Mask = - it #=copy digit, -=skip digit, other=replace digit
Required Manual Setup

Write.Mask = HiHHiH #=copy digit, other=replace digit

Required Manual Setup

Misread.Trigger.Count = 5

EStop if this many successive misreads occur.

Fire.Sequence =0101010101010101 1=Fire, 0=Skip Piece (16 digits)

[Printer]

Enabled =1 Printer Enabled: This will always be "on" or a value of 1.

1P = localhost Defines how the printer is connected. It will ALWAYS be "localhost", meaning
the inkjet software is located on the same PC.

Port =700 ALWAYS port 700

Piece.Width.Inches =1.5

@ User s Manual

This entry needs to match the size of your template, as defined in the inkjet
software as Paper Width ;From Printer's "File/Print Setup": Paper Size - Width

Required Manual Setup
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IR Track System Settings.ini

Configuration Files

Dist.From.Sensor.Inches = 6.25

This entry needs to match the value of the "Distance From Sensor" that you
measured on your form, and also entered in the inkjet software. ;From Printer's
"File/System Setup": Board1 - Distance from sensor.

Required Manual Setup

Print.Warning.Msecs =50

Timing Graph's "Yellow Box" size (only affects graph display).

[Controller]

Comm.Port =1

Comm.Port= Defines which serial connection you are communicating with the
PC.

Sensor.Invert.Bitfield = 00000001

On option to change the bitfield of the programmable sensor of the IR Track.
This is usually left as is, and really would only need to change if a different type
of sensor was used.

Cycle.Sensor =2

The number that is placed here is the actual connection that is made on the
camera controller. In this example, the sensor is physically connected to "Input
2" as marked on the back of the camera controller.

EStop.Output =1

The number that is placed here is also the actual connection that is made on the
camera controller. In this example, the cable that is connected to the rewinder
for the stop signal, is physically connected to "Output 1" as marked on the back
of the camera controller. ;Relays 1-4.

EStop.Polarity = OE

Only 2 choices for entry -> "1" or "0"; This is determined by the stop
conditions of the transport-- is it a normally open circuit? or a normally closed
circuit? ;0=>Normally open, 1=>Normally closed.

Camera.Trigger. PWMsecs = 20

[Log]

Folder=C:\

Date-Time Format="%m%d%y-%H%M%S" log?, e-stop?, trigger count, log code, log text, EStop Message
App Open =1,0,1,A,Program Start

App Close =1,0,1,B,Program End

Transport Stop = 1,0,1,C,Transport Stop

Transport Start = 1,0,1,D, Transport Start

Piece Fail =1,0,1,E,Piece Fail

Piece Success = 1,0,1,F,Piece OK

Piece Derived = 1,0,1,G,Piece Removed

[Debug]

Enabled=1

Debug Filename=

Show Timestamps=1

Mask=-1
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A

Activate Diverter 6-2
Activate e-stop 6-2
Adaptive Global 5-6, 5-8
Adaptive Local 5-6, 5-8
Assign 4-2

Attacher 2-5

audience 1-1

Auto Setup 4-7

B

Blobs 5-11
Blue Rectangl 5-2

C

Calculate Light on Dark settings 5-5, 5-10
Camera Images 6-1

Camera Tab 5-1

Camera Zoom 3-5

CD 1-1

Character Length 5-5, 5-7, 5-10
clear zone 5-3

Configuration Files 6-1
Connections 2-7

conventions 1-1

customize 3-3

Cycles from Exit 4-6

D

Data Matrix Barcode Template Placement 5-3
Data Matrix Symbol Sizes 5-4
Debug Utility 6-2

Debug Window 3-6

Decode Image 4-9

Decode on Tool Update 4-9
decode Timeout 5-5, 5-10
Delay 4-6

delete camera 4-5

Diagnostics 6-1

Display Area 3-3

display area 3-3

Distance from Sensor 2-18

Index

Diverter 4-6
document structure 1-1
dongle 2-11

E

Enabling the Job 2-13
existing configurations 5-9
exposure 5-2

F

Fixed 5-6, 5-8

focus 4-4

Folders 2-5
Friction-Feeder Style 2-2

G
gain 5-2
H

help 1-1
Histogram 3-5

I/O settings 4-6

I/O test 6-2

I/O Timing 4-8

Image Refinement 5-2

Image Tools 5-2

Images 6-1

Input Camera 2-12, 2-19

Inserters 2-2

Installation 2-1,2-6

installation 2-11
software 2-11

Intensity Histogram 3-5

interface 3-1

IR Track 2-10,2-12, 2-14

L

Linear Barcodes 5-6
Local 5-6
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Log reads 5-6

Machine Diagnostic 6-2
main window 3-2
Match 2-12

Match and Print 2-12
Matrix size 5-5

Menu Bar 3-2
Minimum score 5-10
mismatches 4-7
Misreads 4-7

Missing Records 2-13

N

New 3-5

(o)

OCR A 59

OCR Alphanumerics Tool 5-9
OCRB 5-9

Open 3-5

open 3-1

open application 3-1, 4-6
orientation 5-2

Outline Blobs 5-11

P

Physical Install 2-6
Placement 2-1
PLC-type Inserter 2-9
Power Up 2-12
Printer Settings 4-7

Printing and Converting Issues 5-1

Properties 4-5

R

Read and Print 2-12, 2-13
recognition 5-13
Refinement Settings 5-2
Remove Camera 4-5
Remove tool 5-2

Reset Pass/Fail Counts 4-9

@ User s Manual

Results Area 3-5
Results area 5-2
Rewinders 2-5
Run 4-8

Run tab 3-4

S

Save 3-5
Save As 3-5
Saving Camera Setup 4-3
screw 4-4
serial number 4-2
set screw 4-4
Setup 4-1

auto 4-7
Software Diagnostics 6-1
software install 2-11
Stitchers 2-5
Stop Conditions 4-7
Stop on Error 4-8
Swing-arm Inserter 2-8
Symbol Sizes 5-4
Systems 2-12

T

tab selection area 3-3
tabs 3-3

Test serial connection 6-2
Threshold 5-5, 5-8, 5-11
Title Bar 3-2

Toolbar 3-3

Train 5-12

Transport Bases 2-5
trigger 5-2

Trigger Camera 6-2
Trigger Ticks 2-18
troubleshooting 6-1

U
Unique Identifier 2-14

\'

view menu
customize 3-3
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Z

Zoom 3-5
Swing-Arm Style 2-4
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